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GENERAL
GSCalc is software for the real shooter because it provides the fastest and most accurate 
store and analyze the on-target results you get from each of your important shooting projects
GSCalc, you'll need: a Windows-based PC; a scanner, including scanning and image editin
ware that will save images in Windows bit map format (".bmp" extension); and a printer.

Like virtually all software, you’ll need to use GSCalc  in a particular way and it will produce th
results you want only if you use it in that way. If you will just work your way through this man
using your own PC, scanner, and printer, you'll soon be obtaining, and storing, target resu
extract all possible information from each target group. With this information, you'll be able to 
realistic comparisons as to whether a load change has made a difference or not. You'll also b
find, view, and print your stored targets full-size on screen and on paper.

At this time, please print this file out and then close or minimize your word processing softwar
it off the screen). Refer to your hard copy of this document for the rest of your introduction t
software. This will allow you to make notes in the margins, as needed, and will keep you from
ing to try to read "around" the other things on the screen (or switch your word processor in f
the other items) in preparation for your next move. Keep your hard copy in a handy place so y
find important settings you have noted on it in the event that you have to reinstall the softwar

The Plan
It’s always a good idea to take a look at the forest prior to looking at the trees or their leaves/n
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So, here’s the overall strategy. GSCalc can load either a scanned target image (in order to crea
shot-location file ["gsc" file]) or it can load an existing shot-location file to show you a virtual im
of your target and present crucial target statistics.

You’ll use your scanner (properly set and adjusted) to create an image of your target. You’
load that target image into GSCalc for viewing and will use your mouse to "click-in" the on-scre
locations of your point-of-aim and of the target’s several shot-impact locations. GSCalc records the
location of each clicked-in shot for the group, recording the X,Y location of each shot relative 
location of the point-of-aim.

You can then save this shot X,Y location listing as a "gsc" file. At any time, you can load this 
gsc file into GSCalc to recreate a virtual image of your target. Therefore, after saving the gsc
you no longer need the large scanned-in file of your target.

Alternatively, if you care more about group sizes, per se, than about their distance from the point-o
aim, you can ask GSCalc to recalculate the group as if the group’s center-of-mass were its poin
aim. You would then save THAT as your "gsc" (shot placement) file, and be able to load it an
reate the target image (showing dispersion of the shots around the group’s center-of-mass
time desired. The software allows you to save both types of groups, if desired, as separate fi

Regardless of whether your "gsc" file records the shots relative to the point-of-aim or the g
center-of-mass, GSCalc provides valuable output regarding the group "size" (the center-to-ce
distance of the two most widely separated shots) and provides a far more valuable analysi
form of two other parameters: the mean radius (from the group’s center-of-mass); and the s
deviation of the radii (from the group’s center-of-mass). These two values, as described 
encapsulate nearly all the information that EACH shot has to offer, not just the information fro
two most widely separated shots.

With GSCalc, you’ll be able to recreate and print, at a one-to-one scale (or blown up or s
down, as needed to be clearly visible on the screen), every group you have scanned in. Th
isn’t any other means for storing such information that even comes close to what GSCalc can pro-
vide, in that regard, and it takes so very little time to scan in an important target that there’s 
reason to put off enjoying these advantages. This is especially true regarding "proof" targe
shoot for the special handloads you develop that wring the best performance out of your firea

We wrote all portions of this manual in a way that is unlikely to leave a person stranded who 
tle familiarity with computers. For those of you who are quite adept at computer use, thanks fo
patience with the detailed instructions.

The GENERAL section of this manual addresses the basic stuff you just have to know
HANDY ADDITIONAL FEATURES AND CONSIDERATIONS section will inform you abou
special features that you’ll want to know about once you’re familiar with the basics. Let’
started.

Installing GSCalc
Available on the GSCalc website (http://rawilson.net/shareware/index.html) are two similar zipped
files ready for download - one is a standard "zip" file, the other a self-extracting "zip". Both co
identical versions of GSCalc, the choice is yours which to download.  The former, the stand
"zip," requires you to have WinZip  or a similar program available on your PC in order to extract
program’s files. The self-extracting zip is a little larger, but, as the name implies, is capa
extracting the files on your PC without the aid of additional tools. In either case, downloa
desired file to a temporary folder on your PC.

Following the instructions at the GSCalc website, you should have created a "Targets" folder on
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your hard drive (e.g., C:\Targets) and have downloaded the following items to it: this docume
file Greyback.jpg; and the sample target scan image 44_788.bmp.

If you have chosen the standard zip file, using "Start->Run->Browse" (click the Start button, at the
lower left of your screen, choose Run, then click on the Browse button) or Windows Explorer, find
your way to the temporary folder to which you downloaded the program, locate the file "gsc.zip"
and double click on the file. Assuming you have WinZip  or a similar program, this will start up 
WinZip  window displaying the contents of the file. Click on the Extract button and accep
default destination. This will create a set of installation files (in particular "setup.exe") in the current
folder. You can remove these files may after installing the program.

If you have chosen the self-extracting zip file, use "Start->Run->Browse" or Windows Explorer
to locate the "gsc.exe" file and double-click on it. Accepting the defaults will create a set of insta
tion files in a folder named "C:\usr\install\temp\gsc" (again, of particular interest is "setup.exe").
This folder and it’s contents may safely be deleted after the program has been installed.

On most PCs, it’s best, at this point, that you close all other applications running on your PC.
using "Start->Run->Browse" locate the "setup.exe" file described above, click on it once t
"select" it (the icon darkens), and click the Open button and then the OK  button. This installs the
GSCalc program on your PC. Accepting the defaults will put the program and it’s associated f
the C:\Program Files\GSCalc folder and place a GSCalc shortcut on your Start menu (under "Pro-
grams"). 

Once you have a successful installation, you no longer need  the temporary installation files (
ing the initially downloaded zip file) so you can delete them.

GSCalc installs itself in the Program Files folder on your hard drive (C:\Program Files). To sta
GSCalc, you could go to the GSCalc folder in Program Files and then double-click on the targe
icon there. However, it’s a good idea to access the Program Files folder as seldom as possibl
because it contains the special files your PC needs to run properly. Given its sensitive conte
not a good idea to "do work" in that folder. Therefore, we’ll establish a pointer to the GSCalc 
that you can keep on your desktop. When you double click on this icon, it will find and start
GSCalc software without your having to enter the sensitive Program Files folder again.

Clear your screen of all files and programs you have open by closing or minimizing them. UMy
Computer or Windows Explorer to find the Program Files folder off the root of the C: drive.
Double-click on the Program Files folder to open it (if it gives you a warning, just click on th
show files option), then find and double-click on the GSCalc folder. You should now be viewing the
list of files contained in the GSCalc folder. If your My Computer  or Windows Explorer frame
covers the entire screen, then resize it so that you can see your PC’s desktop. (HOW: if the m
the three little buttons in the extreme upper right of the frame shows two frames, then click
This should shrink the size of the frame. However, if it still covers the entire screen, use your 
to pull in the edges of the frame.)

Now scroll down, if necessary, until you find the icon that looks like a target and has the 
"gscalculator.exe" - this is the file for which you want to create a pointer. RIGHT-click once on 
file’s target icon and choose the Create Shortcut option. This will create a duplicate target ico
named "Shortcut to gscalculator.exe". Left-click on the duplicate target icon and hold down your
click as you move the icon out of the My Computer or Windows Explorer frame and drop it onto
your PC’s desktop (by releasing the mouse button). Now minimize or close your frame an
should find the duplicate target (for GSCalc) icon on your desktop. You can leave it there or (bet
yet) you can drag it down and drop it on your Start bar, in which case you’ll have the icon both o
your desktop and on your Start bar.
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Getting a Hard Copy
Since updates are made occasionally to GSCalc it is easiest (and cheapest) to acquire your copy
the program via the internet.  However, if you do not have access to the internet you can re
"hard copy" (CD ROM) by sending $15 (this includes the registration fee) to the address sh
the next section.  This CD ROM contains the "unzipped" installation files and allows you to i
GSCalc like you would any other program.  Future updates to the program will be distribute
CD ROM only by specific request and will be subject to a $5 shipping and handling charge (u
will always be free via the internet).

Registering GSCalc
Several features of GSCalc are disabled until the program is registered - the most important of t
is the ability to calibrate your system (set your Magic Number) for accurate measurements. Reg
tration is still a snail-mail operation. Send $10 ($15 if requesting a CD version) in US funds to

Ralph Wilson
2000 N. Naperville Rd - 2F410
Naperville, IL  60566

Prior to sending the registration fee in blindly, visit http://rawilson.net and use the email link therein
to contact the author and double check that the above address is still valid. Include with you
tration fee a sheet of paper with your name, email address, snail-mail address (especially if
requesting a CD version) and which program you are registering (GSCalc in this case). As soon a
your registration fee is received you will receive an email with the following information:

Your name:_________________________________

Your email:_________________________________

Your Registration code:________________________

Write this information in the spaces above exactly as you receive them in the email. The registrati
program is both white space and case sensitive, so pay particular attention to those items
write them down (we also recommend that you save this email where you can find it later if n
and print out a hard copy to keep with your manual’s hard copy). 

To register your copy of GSCalc, start the program. On startup the program will prompt you wit
"nag screen" requesting that you register your program (by now, you’re probably all too fa
with this nag screen and will be glad to know you’re just about to kiss it goodbye for once an

Click on the "Register My Copy of GSC" button1. This will start another window that has user en
fields for the three pieces of information you gathered above. Type your name, email addre
registration code into the appropriate boxes exactly as they appeared in the registration email y
received. A handy way of doing this is to have the email open in one window while you’re reg
ing your copy of GSCalc.  You can use your mouse to highlight each field in the email (click 
hold down the left mouse button as you move the cursor across the appropriate text in the
"Copy" the field onto your clipboard (type control-c ), click your mouse in the appropriate text bo
of the registration window, and paste the information there (type control-v).  After you have entered
all three fields exactly as shown, click the "Register Now" button. If you have entered all the 
mation correctly, you should get a pop-up window that says "Registration successful."  If yo
unsuccessful, double, triple and quadruple check that you entered the information exactly as

1.  You may also start the registration process any time the program is running by clicking on "Help->Reg
Group Size Calculator"
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received. If you still have trouble, contact the author by visiting the website at http://rawilson.net
and using the email link.  Once you have registered, future updates to the program are free a
registration code will remain valid.

Once registered, the program will remember your favorite settings each time you exit and res
program. But, more importantly, it will now allow you to calibrate your system by setting 
Magic Number.

Calibrate Your Scanner
Next, use the "Set Magic Number" feature, in GSCalc, to calibrate your scanned images such th
the Shot Scanner will accurately measure your targets. Before the program will allow you t
brate your system, you must have registered your copy of the program.

To calibrate your scanner/scanned images/display:

1) Start GSCalc then click on its Options tab and select either Metric or English units. [Hin
if it reads "Metric ," then you are set up for English units and you would click on Metric
to change to metric units. So, if you want English units (inches), this option should
"Metric ."]

2) Click on the Display tab and select the Set Magic Number option. This will bring up a
window for you to input your magic number. For now, set the magic number to 1
click the OK  button.

3) Boot up your scanning software and set it for black-and-white scanning at 72 do
inch. Place an accurate ruler directly across the glass of your scanner (so that th
will be horizontal in the resulting image) and scan in a picture of it. [Hint: for some s
ners, or scanning software, it may be necessary to make sure the scan destination 
the monitor screen]. Make NO changes to this image. Save it as a .bmp (Windo
map) file by clicking on the File tab of your scanning program and selecting Save As,
then name the file "ruler" and choose "Windows bit map (*.bmp)" as the file type. [H
with some software, this file type is called "Windows or OS/2 bitmap (*.bmp).]. Be
saving it, be sure that its destination folder is the Targets folder you’ve created for your
GSCalc work. Click the Save button. Your ruler.bmp  image file is now saved to you
Targets folder. [Hint: if your scanning-an-image editing program will not output files 
bmp format, you’ll need to get one that does - like Jasc Paint Shop Pro.]   

4) Hold down the Alt key and hit the Tab key [abbreviated "Alt-Tab"] to return to GSCalc.
Then open GSCalc’s Shot Scanner by clicking on the <GO> button (at the bottom of the
frame), check that the Files of type: frame indicates Scanned files (*.bmp), and that the
Look in:  frame indicates the Targets folder, then find select (single-click on) you
ruler.bmp  file and click on the Open button to load the scanned target image in
GSCalc. You should now be looking at an image of your scale, with GSCalc’s Shot Scan-
ner utility, and the scale should extend horizontally across the page.

5) Using the Shot Scanner, first establish your "zero" reference mark by RIGHT-clickin
exactly on the left-most inch/cm mark, then move to the right and LEFT-click on the
inch/cm mark. In the companion Trajectory Results frame, your first LEFT-click will
show the X and Y coordinates of that location, compared to your 0,0  location (the 0
tion on the scale, where you RIGHT-clicked). The "X" value (of the X, Y pair) will 
your "Magic Number." In other words, the measure of 1 inch (or cm) on the 100% sc
the "Magic Number" for your particular system. A number in the range of 900 is typ
You can obtain a more accurate number by measuring a span of several inches/
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dividing the displayed number by the number of inches measured. Once you have
mined your Magic Number, write it down here:

My Magic Number is:  _____________

6) Close GSCalc, then re-open it and re-set your Magic Number to this value [click on
Display tab, choose Set Magic Number, enter your number in the window, then click th
OK  button]. From now on, GSCalc will remember and use your Magic Number. The on
reason you’d need to change it is if you change your computer monitor, or scann
your scanner’s software.

GSCalc has a special way for processing small groups, such as the ones you’d expect to obta
certain premium varmint or benchrest rifles. This will involve two more ruler-scans, using a s
approach, to validate that you are doing everything right. We’ll cover this later on in the Tricks For
Analyzing Small Groups discussion in the ADDITIONAL FEATURES AND CONSIDER-
ATIONS section. For now, let’s go over how to input shots from a scanned target.

Saving And Then Clicking-In A Scanned Target
Note: Once you’ve worked your way through this document, you may have need for a shor
critical reminder points. In that case, look for the "Short-Cut" listing (see below) at the start of eac
topic heading. The first time through, just skip over all of the Short-Cut listings.

Short-Cut:  Let’s assume you’ve already created a project folder and saved your tar-
get-scan bmp file there. In Group Size Calculator, import your target’s bmp file.
This opens the Shot Scanner window. Check the scale value (usually = 100%).
Choose a cursor that matches your shot holes as closely as feasible. First, RIGHT-
click on your point-of-aim, and then LEFT-click each shot-hole, in turn and, last of
all, hit the Done button. You see your target now as a virtual target. Save it as a gsc
file. GSCalc can open up your gsc file at any time to give you your virtual target
view and target statistics.

It is obvious that, before you can work with a scanned target image, you must scan that targe
ever, it’ll be easier and faster for you to get familiar with GSCalc if we use an existing scanned ta
get image, for now, and then address the subject of target scanning later on.

One of the files you were supposed to download (from the GSCalc website to your Targets folder)
was 44_788.bmp. This is the target image we’ll be using for your initial run-through with the s
ware. However, it also serves as a good example of how you’ll want your scanned target im
look - all bullet impact locations show up crisp and clear. Boot up your scanning software (or
image-editing software) and use it to open the file 44_788.bmp. Note how clearly you can see eac
of the 10 shot strike locations (shot with a Remington Model 788 rifle in 44 Magnum caliber a
yards). This is how your scanned targets should look. For now, let’s assume that you’v
scanned-in this image from your target.

Create Project Folder - Before you can save this target image (remember: we’re pretending
you’ve just scanned it in), you must create a project folder, within the Targets folder, that will hold
all of the image and other files for this project. Give your new project folder a name that will 
sense months later when you see it again. Since our purpose, here, is to give you a few les
how to get the most out of GSCalc, let’s name the new folder Lessons. [HOW: Using either My
Computer or Windows Explorer, drive to the Targets folder and then tag the File tab and select
New, and then choose Folder. A new folder icon will appear in the listing and you can type in
name (in this case, Lessons)].
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Save Scanned Target Image To Project Folder - Use Alt-Tab to go back to your scanning progra
(it becomes the "active window," as indicated by its colored head-bar). Your target image is re
save. We’re pretending that you’ve just scanned it in, so lets save it, now, to your project 
(Lessons). Choose the File tab, then select Save-As. Options from here on are software-specific, b
you’ll need to: name the file [let’s use "44_788"]; choose the file format [always Windows bitma
(*.bmp)]; designate the destination [in this case, the Lessons folder, located in the Targets folder];
and hit the Save (or OK ) button. Your sample target is now a bmp file named 44_788.bmp in the
Lessons folder. This is important: close the image in your scanning software (hit the "X" in the
image’s upper right corner) so that the file is available for other software (e.g., GSCalc) to
open.

Open The Target - Open GSCalc (if it isn’t already). If it is not maximized yet (doesn’t cover th
entire screen), then click the middle of the three little boxes in the upper right corner of the fra
GSCalc should now cover the entire screen. That’s how you’ll want to work with it from now o

Load your saved target scan as follows:  click on the <GO> button (center of bottom of the window
to bring up the file choice window; in the "Files of type:" frame, click the button on the right en
and choose Scanned files (*.bmp); if necessary, click the button on the right side of the frame at
top of the window and move to the current project folder (in this case, the Lessons folder); find and
select (single-click on) the 44_788.bmp file; and hit the Open button.

Note that you now have three GSCalc frames showing: the Shot Scanner window, which shows
your scanned target image; the Trajectory Results window, which will record your shot-identifica-
tion information; and the Group Size Calculator window (we won’t use it again until after click
ing-in the shots).

At the top of the Shot Scanner window will be a scale value. For most work, you’ll want it to rea
"Scale = 100%" (as discussed later on, you only use the 200% and 400% settings for target im
you’ve scanned in to produce a magnified view).  If it doesn’t read 100%, tag the Scale tab and 
choose 100%.

Choose Your Cursor - Before clicking-in your strike points, it’s best to change your cursor to a 
that most accurately reflects that of your strike holes. In our sample case, choose the Cursor tab and
pick Duplex… and then choose Large Duplex. You can try out the other cursor shapes and size
your own targets later.

Establish Your Point-Of-Aim -  Before clicking-in your actual shots (using the usual left-clic
you should first click-in your point-of-aim on the target using a RIGHT-click of your mouse. In our
case, with the 44_788 image, the point-of-aim was at the bottom of the black triangle that ext
down from the top of the image. Go ahead and RIGHT-click once on this point-of-aim. No
appears to happen. However the location of each of your other shots will be given as relative
point-of-aim location. If you don’t like where you set the point of aim, or think you moved as
right-clicked, simply realign your cursor and RIGHT-click again.

Click-In Your Shots - Think of a sequence for clicking-in your shots so that you will be sur
avoid either clicking a given shot twice or leaving a shot un-clicked, then LEFT-click each strike-
point in turn (one LEFT-click per strike-point). For purposes of our current target, lets start wi
clump of four shots and then proceed clockwise around the pattern. As you click each shot 
note that its X,Y coordinates appear in a growing list in the Trajectory Results window.  GSCalc
uses the center of each shot for all calculations so be sure to center the cursor accurately
clicking the LEFT mouse button.

When you are done, count the number of X,Y locations shown, to be sure that you didn’t mis
and be sure you didn’t sample any of them twice (i.e., for our sample target, you should ha
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X,Y data lines, each different from the others). A version of this X,Y listing will constitute y
main file (called a "gsc file") for this target. . . GSCalc uses this information to draw your target an
as the basis for recreating all Group Statistics values. If a shot is missing and you can de
which it is, simply align the cursor on the shot and LEFT click - it will be added to the list. If
can’t figure out which is missing, or if you feel you have somehow messed up while clicking 
shots, simply click on the "Clear" tab and start over. Clicking-in takes very little time, so re-do
is no problem (but don’t forget to RIGHT-click on the point-of-aim before redoing your left-clic
strike locations).

If all is OK, then click the Done button at the bottom of the Shot Scanner window to complete the
file. 

View Your Virtual Target & Target Statistics -  When you click on the Done button, the Shot
Scanner window disappears, the Trajectory Results window changes to the Group Statistics win-
dow, and the Group Size Calculator window displays your target with a red circle centered on 
point-of-aim, with a green X on the group’s center-of-mass, and with each shot-strike location
cated by a circle. 

We’ll fix the hole caliber later but, except for that, the virtual target should now look just exactly
the one you shot, but it’s on a grid background, the point-of-aim is shown, and the shots are 
cles (not ragged holes). The text in the Group Statistics window will read something like the fol-
lowing, for our sample target (yours may vary a bit):

***********************************
file : D:\WPFILES\TargetAnalysis\Manual\Lessons\44_788.gsc
From 44_788.bmp (sample bmp for practice)
Number of Shots: 10
Number of Fliers: 0
Group Size: 4.151 in.
Average Radius: 1.291 in.
Radius Standard Deviation: 0.497 in.
Group Center: (-0.464, 1.282)

Note that the "Group Size" designation is the conventional center-to-center spread between 
most widely divergent shots. This standard parameter represents about the best possible
throw away around 80% of the information your target can provide you.

A much more useful parameter than "Group Size" is the "Average Radius"  [the average distance b
which a shot misses the group center-of-mass = (Σ radius) / (number_of_shots - 1) ], because this
includes consideration of the location of each shot in the group, not just the two most widely
rated ones (i.e., the two oddest shots). It IS important to consider the two oddest shots in the
but that’s no excuse for ignoring the information that the more typical shots provide. Characte
your load by reference only to its two oddest shots is like characterizing the human race by
Charles Manson and Adolf Hitler - neither a pretty picture nor an accurate one.

The "Radius Standard Deviation" (RSD) parameter is, roughly, the average variation in how mu
each shot’s radius differs from the Average Radius. Mathematically, it looks 

this:  , but don’t let that throw you. . . . it’s far easie

to use than to calculate, and GSCalc does all the heavy lifting for you. For most users, this param
is useful for validating that you have a "typical" group. Most typical groups have a RSD t
around 1/4 to 1/2 of the group’s Average Radius value. By contrast: a ring-shaped group (no h
the center. . . indicating a action/barrel bedding or throating problem) will have an RDS value

radius averageradius–( )2∑ 
  number of– shots– 1–( )⁄
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<20% of the Average Radius value; and a group with lots of fliers (i.e., a good cluster in the 
and then several widely-divergent shots, indicating either a bad load or bad bullets) will ha
RSD that is >50%.

These proportion-limits are just general rules of thumb. In most cases, you’ll be clicking-in
good normal groups that represent results from good loads shot from good pieces, so the R
be around 1/3 of the mean radius. However, if you are clicking-in an odd group from a troubl
rifle (perhaps to send, by e-mail, to your riflesmith), then don’t be surprised if you get an RSD 
considerably larger or smaller than this.

The Group Center values are the X,Y coordinates of the group’s center-of-mass, relative
point-of-aim. This can be very useful for telling you how much to change your scope-setting s
you get the desired mean strike-point elevation above the point-of-aim at the distance at wh
shot your reference target - typically, 100 yards. In our example, and assuming our scope 
minute-of-angle clicks (around 1/2" change per click at 100 yards), if we wanted the group
centered and two inches over the point-of-aim at 100 yards, our Group Center values (-0.464
indicate that we’d have to come right one click and come up two clicks. [Note: this Group Center
value is always 0.00, 0.00 if the group has been redrawn to show the aim point as the center-
of the group, as discussed later.]

Adjust Caliber -  The default shot-strike diameter for the Group Size Calculator window is 30 cal-
iber. If you shot your target with something other than a 30 caliber weapon, you’ll need to adj
displayed shot diameter. In our case, we want it to mimic 44 caliber (0.429") holes, so we adju
follows: choose the Display tab; pick the Set caliber… option; click on the warning’s OK  button (it
says that the program will re-display the target after choosing. . . just what you want); pick th
rect caliber (0.429", in this case); and click the Done button. Your target reappears and, now, sho
look "just right." Note: Since GSCalc uses the center of each shot for all its calculations, the cali
has no affect whatsoever on the group statistics.

Save Your P.O.A. Target Analysis - As of yet, there is no record of your target analysis, relative
your point-of-aim (P.O.A.) . . . it’s all sitting in your PC’s RAM chips! Let’s save your work.

If you don’t care about the point-of-aim reference point, but DO care about the group charact
themselves, then go to the next section. If you are mainly interested (or are ALSO interes
showing your group relative to your point-of-aim, then your present analysis is your desired
and you should save it as follows. In the Group Size Calculator window: choose the File tab;
choose the "Save .gsc" option. This automatically saves the X,Y listing file you saw previou
under the same name, and in the same folder, as the target file you used, but with a ".gsc" ex
[Translation: For our sample target, it saves a file called 44_788.gsc in your current folder (Les-
sons).]  If you wish to view or analyze this target again, you’ll go to that project’s folder [the Les-
sons folder, in this case] and open the 44-788.gsc file.

Blow Away The BMP File - Unless you need to show proof to someone that your analysis r
does represent the target you shot, you no longer have any need for the large .bmp target im
If you always keep them, they’ll eat up your hard drive space at an astounding rate. The tr
most cases, is to delete this source file, after you click it in and save the gsc file. From then 
can rely on the small, efficient .gsc file to recreate a virtual image of the target and its sta
(especially the valuable Average Radius parameter), whenever you wish.

The best time to eliminate your .bmp file is right after you’ve converted it to a saved .gsc file. I
case: find the file, with My Computer or Windows Explorer, then select it (single click), and hi
the Delete key and answer Yes when asked if you want to send this file to the recycle bin. By op
ating in this way, you can store an almost unlimited number of targets without the slighte
encumbrance of your hard drive’s storage room - the .gsc files take up almost no space at
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contain all information necessary for you to recreate the target image, and its Group Statis
will.

Recasting The COM As The POA - Often, in load development, you’ll have little concern abo
the target’s point-of-aim (POA). Rather, you are concerned about the how widely the shots pa
around the group’s center of mass (COM ). In that case, you’ll want to recast your analysis to b
itself on the COM, rather than on the POA. To do that: in the Group Size Calculator, choose the
Run tab; and choose the Zero Group option. This changes each X,Y coordinate (in the hidden .
file that is held in your PC’s RAM) to be recast to represent the shot’s location relative to the g
COM.

At this point, save your .gsc file as follows: in the Group Size Calculator window: choose the File
tab; choose the "Save .gsc As" option. Unlike with the "Save .gsc" option, this brings up a window
that lets you choose the file name and location. Given that you located your target source f
.bmp target scan) in your project’s folder (Lessons, in this case), you shouldn’t have to change t
destination. If you have NOT saved the POA-based file, then just hit the Save button and your file
will have the same base-name as your .bmp target scan file (but with a .gsc extension). How
you’ve already saved your POA-based analysis (e.g., "44_788.gsc") then you’ll need to give your
new file a different name to avoid overwriting that file. In that case, one way is to just add "CO
the end of the file name ("44_788COM.gsc"), prior to saving it. It is important to leave the ".gsc
extension on the file name.

Scanning Targets

Short-Cut - Create a uniquely-named folder for your project, within the Targets
folder; reset your scanner to black and white and 72 lines per inch before scanning
any target for analysis by GSCalc; always place your gray-colored target backer
behind the target before scanning it; never "resize" the scanned image before saving
it; and always save the target image in ".bmp" format to the folder you’ve created for
that project. If your scanning & image editing program will not export bmp files, get
one that will.

Print And Use The Grey Target Backer Sheet - Your scanning of targets will go much faster an
easier if you place a piece of grey-colored material behind (facing the back of) your target. Th
make the holes clearly visible regardless of whether they are in the white or black portions of 
get. The file you’ll use to create your backer sheet - Greyback.jpg - is one of the ones in the zippe
file you downloaded from the GSCalc website, so you should find it in your Targets folder. If not,
you can download another copy of the Greyback.jpg file (at http://rawilson.net/shareware/Gsc
Greyback.jpg ). You’ll not be importing this file into GSCalc, so it is in the heavily-compressed jp
(JPEG) image format to make it quicker for you to download.

Most scanning software will allow you to import and view graphics files, including bmp files. O
your scanning software (or an alternative image viewing/editing package like Windows Imaging,
that is on your system), then use it to open and then print Greyback.jpg, which you’ve downloaded
to your Targets folder [chose the File tab and tag the Open option, then steer to your Targets folder,
check to be sure that it is set to show either jpg files or "all files", then find and select the Grey-
back.jpg file and hit the Open button]. It may not look like much (just a colored image). That’s O
Just ask the program to print it (be sure your printer is ON, then chose the File tab and tag the Print
option). The resulting hard copy will be a grey-colored sheet with a narrow white margin. Kee
sheet in a handy place so that you can find it whenever you scan targets. However, if it gets
damaged, you can always reprint another one.

Scan and Save Your Target Image - There are so many scanners available! Typically, each 
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comes bundled with a piece of scanning software that acts as the interface between your sca
the PC (without this software, the scanner would be useless). There are nearly as many b
scanning software as there are of scanners. Therefore, it is up to you to become familiar wi
scanner and its attendant software. Once you have become able to scan photos and drawin
your setup, the following instructions will provide more than enough information for you to c
target scans that will be useable by GSCalc.

Stick your target into your scanner and place your gray-colored target backer grey-side-dow
the back of your target. Set your scanner to scan a black-and-white image at 72 dots per inc
Scan the image and then save it without changing its dimensions at all. Before saving, it is OK
your software’s functions to: "Sharpen" the image; adjust the contrast and brightness; and crop
image so it shows only the group. Just BE SURE to avoid changing image dimensions or d
inch (should be 72 dpi). All of these functions will be program-specific, but you should be 
them for scanning photos and such too, so they should be second nature by now. Use the p
Save As function (under the File tab) to save it as a "Windows bit map (*.bmp)" file to the proje
folder you have created for it in your Targets folder.

The image quality you should expect is best viewed by example (see instructions above for 
the "44_788.bmp" file that you downloaded, as instructed, with your software). If your target b
files make it easy to identify the separate strike-points, as shown in the sample 44_788.bmp file,
you’ll have no trouble in using the file to create a very accurate gsc file that will recreate your
pattern at will. 

Nearly all image editing software will import an existing bmp files, like 44_788.bmp. However, to
create your own target scan bmp files, you must be sure that your image scanning/editing s
will export files in bmp format. Some "Limited Edition" versions of popular scanning-and-im
editing software will export only in one format (not bmp). These will not work with GSCalc.

To find out if your image scanning/editing software will export in bmp format, use it to o
44_788.bmp (open your imaging software and then tag the File tab, choose Open, and then "steer
it" to your folder [in this case, C:\targets\lessons], tag the 44_788.bmp file, and hit the Open key).
OK, so it imported the image file. Now well see if this dog can hunt: tag the File tab, choose Save
As, then tag the tab button at the right end of the "Save file as:" frame. Look for an option like,
"Windows bit map (*.bmp)." If you find a Save As option that names the ".bmp" format, then y
image scanning/editing software will work fine. If not, then you’ll need to buy and install comp
scanning/editing software - like Jasc Paint Shop Pro.

Once you have an accurately rendered gsc file, you’ll have no more use for the large, cumb
bmp scanned image. Therefore, typically, once you have a good gsc file of a target, it is w
delete the scanned bmp image, given that it is just taking up valuable space. With a good g
which takes almost no space, you can readily recreate your target pattern on-screen any t
want, and you can easily print it out too.

Comment Your GSC File Immediately! - The first line in a gsc file is a comment line and as
comes from GSCalc may not be particularly informative to you.  It’s a good idea to change this c
ment line to something meaningful quickly before you forget what this file relates to.

Your Windows installation includes a simple little text viewing/editing program called Notepad that
you can find as follows: hit the Start button (lower left corner of your screen); select Programs;
select Accessories. You will need to use Notepad frequently, so create a shortcut for it (in the sam
way as described, above, for the GSCalc program) and place it on your desktop and in your Start
button bar, right next to your GSCalc button.

Boot up Notepad and load the gsc file you’ve just saved (44_788.gsc, in this case), as follows. In
Notepad: click on the File tab and choose Open; in the Files of type: frame (near the bottom of the
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Open window), click on the button at the right of the frame and choose All Files; in the Look in:
frame (at the top of the Open window), click on the button at the right of the frame and drive to 
correct folder in the Target folder (in this case, the Lessons folder); single-click on the correct file
(e.g., 44_788.gsc) and then click on the Open button. This loads the chosen file into Notepad.

Replace the entire first line of the file with a brief target description. In our case, substitute, "S
44mag 788 target showing POA".

Now, save the revised file either by hitting Cntrl-S or by tagging the File tab and choosing the Save
option.

Good work. Now, go and do the same thing with your 44_788COM.gsc file (gsc file made with all
shots recorded relative to the group center-of-mass). Once you have both files commented, 
the next section, where you’ll re-open and look at them using GSCalc.

Viewing And Printing An Existing Gsc File

Short-Cut:  In GSCalc, hit the <GO> button, find your target’s project folder, then
(in File of type: ) choose ëGroup files (".gsc") ’, select your gsc target image file,
and hit the Open button. Adjust the caliber, if necessary (under Display and Set Cal-
iber). To print this virtual target and its statistics, first darken the target image
(choose File then Embolden Target), check that the printer is ON, then hit Ctrl-P.

Viewing A gsc File - Once you have saved a gsc file, it is ready to be re-imported into GSCalc. Lets
do this for the two gsc files we’ve created: 44_788.gsc and 44-788COM.gsc.

Use Alt-Tab to return to GSCalc, then hit the <GO> button. This tells GSCalc that you are through
with the current view and wish to either load a new scanned bmp target image (see start of th
ument) or load an existing gsc file and view the results. Hitting the <GO> button brings up the
Open window.

In the Files of type: frame, click on the button at the right and choose ëGroup files (".gsc") ’. In the
"Look in: " frame, be sure that the software is viewing the correct project folder (Lessons, in this
case). At this point, you should see both of our sample files listed: 44_788.gsc and
44_788COM.gsc.

Highlight the desired gsc file (44_788.gsc, in this case) and hit the Open button. This loads your
cleaned-up point-of-aim based gsc target file into GSCalc.

Is Caliber Correct? - Given a successful loading, you’ll see your sample target and its atten
Group Statistics. GSCalc will assume that the caliber of round you used on your target is eithe
(if you have just booted up the program) or is the same as you specified in the gsc file you ju
ished viewing. Therefore, if you’ve been looking at gsc files shot with a 45-70 and now open
file shot with a 22, you’ll need to change the shot-image caliber (choose Display, pick Set Caliber,
pick the caliber, and hit the Done button).

Printing Target & Stats - If you want to print this material, be sure your printer is on, and then
as follows: darken the target image by selecting the File tab (in the Group Size Calculator window)
and choosing the Embold Target option. Your target’s lines, circle, and impact rings will now see
raaaather too bold; however, that is just what you need for clear printing. Before printing, a
check to be sure your printer is turned on! Choose File and then Print Target  (or use the Ctrl-P key-
board shortcut) and your target image AND its Group Statistics will both go to your printer. Y
find that your target is printed full-size (this can be changed by setting the "Display Scale" under the
"Display" tab at the top of the main GSCalc window). Note that if the description in the top lin
your gsc file is too long, it will just run off of the page (it doesn’t wrap). THAT is why you wan
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include a full description of "How The Cow Ate The Cabbage" in a WORD file that you place in
each project’s folder, as described later on. THAT is the place to get as gabby as you need to
description in the first line of the gsc file must be very brief.

Good. Now, go back and bring up and print the other practice file (44_788COM.gsc). Always
remember to embold the target prior to printing it.

HANDY ADDITIONAL FEATURES AND CONSIDERATIONS

Name Each Unique Project Folder Wisely 

Shortcut:  Organize and name your project folders so you can find your project,
from among many others, long afterwards. One good way is to have one folder for
each of your firearems (in the Targets) folder, and then create a project folder within
that rifle’s folder for each project you have for it.

The mechanics of creating a folder are included in the discussion of "Saving And Then Clicking-In
A Scanned Target," above. However, a folder’s name is virtually useless unless it will save tim
making sense to you in the future. For one thing, it’s wise to keep all target analysis project 
in the Targets folder, since each project folder will contain target analysis (.gsc) files. Howeve
also important to realize that, after a while, you’ll have LOTS of project folders in that parent f
Therefore, the trick is to name each project folder such that you will have a good chance of
nizing it years from now, by its name and location alone. In addition, in each project folder, it’s
to have a WORD (or other word processor) file that describes the project in more detail. That w
the future, you can quickly home in on a group of two or three project folders. You then can u
project description file in each folder to identify which one of the several folders is the one yo
after.

We suggest the following two-level approach to naming your project files, plus the addition of 
rative description file in each folder, containing a short description of the purpose of that proje
the date, or dates, on which its experiment was carried out, plus a list of the loads tried an
opinions of each. It just takes one line per load that you tried.

At this point, you should be capable of creating folders at will for storage on your hard drive. 
then please reread the material above.

We suggest that the first "level" of folders should be the guns themselves and the secon
should be the projects you carry out with each gun. Therefore, if you have a Remington 788 in
chambering, you could create a folder named "788_3030" in your Targets folder. If you did an accu-
racy work-up using Lyman 31141 cast bullets in February of 2002 with it, you could nam
project file "L31141_Feb02". If you did another project with that same rifle and bullet later t
same February, it could have a folder named "L31141_Feb02b". This project folder, and all others
for that rifle, would be in the 788_3030 folder, and would have gsc files for every important targ
that you shot for that project. As you can see, with this approach, it’s easy to create a new fold
a location and name that will make it easy to locate in the future. . . you just go to that rifle’s 
look for a file that matches the bullet used and, if there are several, pick the one in the rig
range. However, as described below, putting a date on the project folder is only a good ide
you are unlikely to do further work on that project subject.

An alternative way would be to organize your load project folders (within a given rifle’s folder)
by bullet, with no date in the folder name. Then, within that bullet’s folder, put all the final-load
erence targets for each powder you’ve found works well with that rifle/bullet combination.
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WORD file in that folder would list all the loads you’d tried under each powder. . . you could s
your favored loads, for each powder, in bold type, in addition to giving it praise in the text. The
is to organize it like you would a regular set of files in a file cabinet.

Given the above-described project, you should create a Microsoft WORD file (or whatever your
word processing software is) that described the goal of the project, lists the bad loads tried, a
the final load or loads and any conclusions (e.g., "This rifle requires all cast bullet loads
jammed firmly into the throating. Otherwise, it just won’t shoot well."). This file, and your note
it, will save you lots of time later because it will memorialize your loads-tried and conclusions

Note that most targets you shoot, during load work-up, would be 3- or 5-shot groups and 
NOT be scanned-in and then clicked-in. After all, bad loads seldom shoot well, so will give 
selves away quickly, whereas good loads seldom shoot a bad 3- or 5-shot group. Using jus
shots per test load makes sense.

Your gsc files would be only for the final load(s), for each of which you would shoot a group w
least ten shots (see the discussion of "Sample Size," below). However, your WORD file will list all
loads tried and any relevant problems noted, like: "22.5gr of H322 = 2300fps/80sd: velocity 
variable". Reading through this file, before going out and trying some new loads for that bull
rifle, will save you lots of time. 

This will be the only WORD file in that folder, so it’ll be very easy to find it whenever you po
around in that folder. If you extend that project later (e.g., you try a powder with that rifle and
let), you can update the WORD project description file and re-save it. Such a file becomes the ke
your understanding this folder’s contents in the future. . . it’s a quick way to record every
you’ve done with that rifle and bullet.

Sample Size

Shortcut:  For any record target (for an important load) shoot at least ten shots.

For load-development projects, it only makes sense to go to the trouble to record your final
For comparisons between two components (say, a softer versus a harder cast bullet of th
design), you’ll first develop the best load for each and then shoot a target for record, using th

Given how much trouble you’ve gone to, it’s important to know how to obtain a group that pro
the most accurate and complete reflection of your final load’s capabilities. You may have s
powders that work well, each with their own bullet, in that rifle. In that case you’ll need to ha
gsc file for each final load. Likewise, for exploratory projects (e.g., "How does one bullet sta
against another, in this rifle?), you’ll end up with just a few key targets, each in their own bulle
cific folder, that you’ll want to print out and compare with each other. You should include a 
about each of these targets in your WORD project description file, and you should include a releva
very-short note in the top line of each gsc file itself, as described above.

Given that you’ll only be using GSCalc on those few targets that represent milestones in your 
development or testing, it is extremely important that you understand the concept of sample size!
Whether you like it or not, in doing these target analyses under GSCalc, you are applying statistics
to your shooting. For your target actually to represent your load, it must have a "sample size"
ber of shots on the target) that is large enough to make it very unlikely that you are misled
results - the larger the sample size, the more reliable the results.

Generally speaking a sample size of 10 is the minimum (10 shots of that load on that target).
can be better, but the benefits start really dropping off at a sample size of 20. GSCalc will allow a
sample size of up to 32. For most purposes, you get the biggest "bang for the bang" with a
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size of between 10 and 15. Use your three- or five-shot groups for load development, giv
assumption that good loads won’t shoot large three- or five-shot groups.

Once you find the load that is "the bees knees," test it with a 10-to-15 shot group. If it doesn’
out, then keep looking. If it does give you a nice tight group, then mark and keep that target a
reference target for work-up with GSCalc. With a carefully-shot group with a sample size 
between 10 and 15, you can depend on the resulting Group Statistics to provide a viable ind
of your load’s capabilities in THAT rifle, when shot in THAT manner (i.e., from the bench, or f
a given field position. . . however you shot that group). That leads us to discussing field posit

Duplicating Field Conditions

Shortcut:  How you shoot a load off the bench is no indication as to how well you’ll
be able to place your shots with it from various field positions. After you develop
your load and shoot a reference group for it, shoot another reference group for each
of the field positions you are likely to use with it. That way, you can tell you and your
load’s actual field performance.

Once you have a load that is just right for your purpose, when shot from the bench, it is impo
realize that there are very few hunting situations in which such a bench is available. The
please consider shooting a 10-round group, with that load and rifle, from each of the field po
you are likely to use it with. Take each such target back and run it through GSCalc. For example, for
a varmint load, shoot a reference group from the portable bench or cross-sticks you use in th
This really helps.

The Average Radius readout is extremely valuable, in this regard. For example, as more 
explained under the Statistical Considerations For Everyone section, if it is a varmint load and
has a mean radius of 0.2", from the bench (for a 100 yard group), but 1.0" from a given sh
stance (for example, from the sitting position) then, if you are shooting at a 2" wide ground sq
it works out that you’ll miss around 1/3 of the time (from that position [sitting] at that distance [1
yards]). From your portable shooting bench, let’s say that same load gives you a mean radius
In that case you’d miss the standing squirrel around 1/3 of the time only when they are at a d
of 330 yards, assuming no crosswind problems. It is these sort of considerations you must
when bringing up and viewing your position-specific groups with GSCalc.

The above rule of thumb applies to tall-and-narrow animals, whether they are standing or 
fours. If, however, you are working with a ROUND target, such as the 8" diameter quick-kill-
for a deer, then the "miss" rate (for that kill zone only) is around 1/2 of the shots at a circle having 
diameter of twice your reference group’s mean radius. In other words, if your mean radius is
a given distance, for that load and shooting position - then you’ll hit a 4" diameter about ha
time at that distance, from that position.

By comparison, what will your "Group Size" parameter (distance between the two most widel
arated shots in the group) tell you? Damn little, that’s what, but it’s a popular mode of measur
so GSCalc provides it in the Group Statistics.

One good way to get a visual idea of the hit reliance of your load is to print out the target an
hold up a scaled-down kill zone against it. For the printout of the 44_788.gsc target you have, your
average radius is 1.3", so hold up a finger-spread twice that wide (2.6" across) centered on th
and you’ll see that, for a standing prairie dog that wide, around 1/3 of the shots would miss at 10
yards and around 1/2 of this shots would miss a circular 2.6" wide target at that distance. To see
it would do at 200 yards, hold up a 1.3" wide strip (the 200 yard 2.6"-wide prairie dog’s equiv
width at 100 yards), and you’ll see that the load would miss around 2/3’s of the time. Reme
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though that your rifle will never again shoot that exact same shot distribution. . . it’s just a sa
So, once again, the larger the sample size the more value you can extract from the target. Th
five-shot groups are for load work-up; ten- to fifteen-shot groups are for record.

For yet another twist on estimating your group’s capabilities at distances other than the one a
you shot the group, see Guessing Accuracy At Different Distances, under the Statistical Consid-
erations For Everyone heading, towards the end of the manual.

Tricks For Analyzing Small Groups

Shortcut:  GSCalc offers a special way to magnify small groups so that you can tell
where each shot went. For most applications, the 2X option (using bmp images
scanned at 144 dpi) works best. For a finished small-group gsc file, you can view/
print the group magnified 2X or 4X.

For small targets, GSCalc has a special feature in the Shot Scanner window (the one you use for
clicking-in shots while viewing your bmp file). GSCalc’s view, in the Shot Scanner window, is
based on the number of lines in the image, and it assumes that your Magic Number will give 
dots per inch of target image. Therefore, if you scan your target image at 144 dpi (twice the
line density), the Shot Scanner will show it magnified twice. Similarly, if you scan in a very sma
target image at 288 dpi (four times the usual line density), the Shot Scanner will show it magnified
four times.

This magnification allows you to see your small group more accurately. There’s an even bette
though. Before clicking-in your shots, in the Shot Scanner window, first tag the Scale tab and
choose either 200% (for a 144 dpi target bmp image) or 400% (for a 288 dpi target bmp image)
Also, before clicking-in, choose a cursor that gives the best fit for your shot diameter, as it app
the magnified image (tag the Cursor tab and try various cursors. . . you’ll need a bigger curso
match your shot diameter than you’d need at a 1X scale).

With your Scale set to match your magnified image’s dpi (i.e., for a 144 dpi image, you have ch
the 200% scale setting), GSCalc will then record your ACTUAL click X,Y locations. In othe
words, you click-in on the magnified image, but GSCalc recalculates and records your click-loc
tions at a 1X scale. For very small target groups, this feature allows you to obtain a more a
location for each shot.

One thing to consider is that each click-in cursor image (e.g., circles) has only one screen s
matter the magnification of the target image. Therefore, one must use a small caliber rifle 
400% (4X-magnification at 288 dpi) setting; otherwise, there will not be a click-in cursor 
enough to provide a good match with the holes in the target. This is less a factor with the 200
magnification at 144 dpi) setting, so it is the most useful of the two magnified target click-in op

In order to keep things straight, when using a line density larger than the standard 72 dpi sett
best to add an "X2" to the end of the file name of a target scanned for 200% viewing (at 144 d
to add an "X4" for a 400% blow-up (target scanned at 288 dpi). This way, you’ll have a clear 
reset your Scale function to 200% or 400% prior to clicking-in that image. GSCalc’s default Scale
setting (when you boot-up the program) is 100%. However, once you reset the Scale setting to
200% or 400%, it will remain there until you either change it again or close down the program
current Scale setting appears at the top of the Shot Scanner window. Be sure to check this ever
time, prior to clicking in, to be sure that the Scale setting matches the target image with which y
are about to work. Otherwise, you could end up producing bad data very carefully - most irrita

The gsc file you produce with these magnified Scale settings represents full scale measurements,
same as if you’d clicked-in on an image scanned at 72 dpi (for the 100% Scale setting). Therefore,
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you’ll want to remove the "X2" or "X4" from the back end of the file name prior to saving y
clicked-in data as a gsc file. The easiest way to do this, once you’ve clicked-in your targ
clicked Done, is to choose the Save gsc As: option (under the File tab in the Group Size Calcula-
tor ) and then eliminate the "X2" or "X4" prior to saving the raw gsc file.

If you want to try this option, then validate your understanding of it first by scanning and s
bmp images of your horizontal (X-scale) ruler at 144 dpi (200% ) and 288 (400%). Bring u
ruler image in GSCalc, set the Scale function appropriately, and then click-in on the even in
marks. The resulting X values (in successive X,Y pairs in Group Statistics or the gsc file) should
read 1" apart. Otherwise, you are doing something wrong.

In addition to clicking-in your small-group targets under magnification, you can also view your
small group’s virtual target (from the gsc file) magnified. When you bring up a small target th
been scanned using this method and then saved as a gsc file, remember that the imported
will default to the 100% scale unless you’ve been viewing other targets magnified. First, chec
sure that the target is displaying in the correct caliber (Display and Set Caliber…). To magnify the
target image, if desired, tag the Display tab, choose Set Display Scale…, and choose either the
2"=1"  option (for 2X magnification) or the 4"=1"  option (for 4X magnification). Note that the
printed grid becomes twice as loose with the 2X compression and four times as loose with 
compression. The distance between each pair of adjacent lines still represents an inch. This
affect the Target Statistics output.

You can print this magnified view just like any other (File tab and then Print Target ). Remember,
though, that it often helps to make the view darker, prior to printing (File tab and then Embold Tar-
get).

Tricks For Analyzing Large Groups

Shortcut:  There’s a way you can hand tally the X,Y locations of shots in groups too
large to scan. Using the hand-typed gsc file, you can view/print the group shrunk 2X
or 4X to fit on your screen/paper.

Believe it or not, there are a number of situations where you could want to use GSCalc, but the
group is just too darned big to fit into your scanner. For example, let’s say that you’re trying 
how well you can keep your shots within a 10" quick-kill-zone at 150 yards, using your favorite
bore revolver and heavy cast bullet load from a sitting position. Out of 12 shots, you got eight 
this zone but, overall, the impacted area of the target is too big to fit into your flatbed sc
Another example would be targets you’ll have while working up loads for 1000 yard shooting.

In such a case, you can work up your gsc file by hand, rather than by using the Shot Scanner on a
bmp file. It’s relatively simple to determine the X,Y positions, type them into NotePad, and save it
as a gsc file. It just takes longer than if you could click-in the shots.

You’ll need a thumbtack, some carbon paper, tape, a pair of scissors, a sized cartridge cas
caliber that you used to fire the target), and gridded engineering paper (1" bold marks and 0.
marks) large enough to cover your group; you can get this paper in a variety of sizes from a
neering/drafting supply store. 

Stick your thumbtack down through your target’s point-of-aim (POA), then pull it back out. Figure
how you’ll want to position your engineering paper so that it will underlay your group. With the
paper roughly in place above the target, pick the heavy 1"-grid intersection that is nearest to 
get’s POA and stick the thumbtack down through it and pull it back out again. This intersectio
be the 0,0 position for all shot-location X,Y measurements.
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Re-insert the thumbtack into the hole you’ve just made in the engineering paper, but from th
tom up, and lay this assembly point-up on a flat surface. Position your target face-up so t
thumbtack sticking up (through the engineering paper) enters the target’s POA perforation. 
the target as necessary to make its horizontal and vertical lines match the engineering paper

Your target and the engineering paper are now registered, one with the other, because: 1) the X and
Y directions of both papers are parallel; and 2) the "0.00, 0.00"  X,Y location on the engineerin
paper is directly underneath the target’s POA.

Hold the two papers together as you move the top end to hang over the edge of the table. 
scissors to cut through both papers to remove the overlapping paper and to cut off as little a
ble of the one that’s not overhanging the other. Put tape around the edge (from one pape
other) in at least two locations along this cut edge. Remove the thumbtack.

Don’t worry. . . You’ll do all of the above twice in the time it took to read about it. Your paper
now locked in registration with one another. Insert a carbon paper carbon side DOWN between the
papers so that it underlies some of the holes. For all holes that have the carbon paper un
them (you can see it through the holes), use the mouth of the sized case to mark the underlyi
neering paper by overlying the casemouth over the hole and pressing down while rotating.
each hole off (on the target) as you complete its transfer. Move the carbon paper around as n
do all of the holes, then remove the carbon paper, lift the target sheet and validate that you
clean, clear transfer for each shot (e.g., count the shots). Remove the target. From now on, y
only with the engineering paper.

Using the 0,0 point as a reference, write down each shot’s X,Y coordinates next to its hole: X
are positive to the right of the 0,0 location and negative to the left; Y values are positive abo
0,0 location and negative below.

Create an appropriately-named project folder in this rifle’s folder (which is located in the Targets
folder on your hard drive). Now you have a place to put your gsc file once you’ve created it. B
NotePad, enter a short basic load/distance description on the first line, hit the Enter key (Re
and enter all of your X,Y values, hitting the Enter key after each one and inserting a comma and
one-or-more blank spaces between the X and Y value on each line (the comma is the trick, th
or spaces just make it easier for you to view). Upon entering the last X,Y pair you can eithe
there or hit the hard return just once.

Use NotePad’s Save As function (under the File tab) to name the file with a .gsc extension and s
it to the folder you’ve created for this project, as follows. In NotePad’s Save As window, be sure
that: the File name: frame contains a file name that makes sense and that ends with ".gsc"; theSave
as type: frame indicates "All Files" (this prevents NotePad from adding a ".txt" to the end of you
file, in addition to the ".gsc" extension you’ve already placed there); and the Encoding frame indi-
cates "ANSI". Hit the Save button. That’s it.

You should have no trouble bringing in your gsc file just like you would any other gsc file. Che
be sure, under Display and Set Caliber, that you are displaying at the correct caliber. The Group
Statistics will be correct, but you probably won’t be able to see many of your shots on the scre
fix that, tag the Display tab, choose Set Display Scale…, and choose either the 1/2"=1"  option (for
2X compressed viewing) or the 1/4"=1"  option (for 4X compressed viewing). Note that the printed
grid becomes twice as tight with the 2X compression and four times as tight with the 4X com
sion. The distance between each pair of adjacent lines still represents an inch.

You can print this compressed view just like any other (File tab and then Print Target ). Remember,
though, that it often helps to use make the view darker, prior to printing (File tab and then Embold
Target).
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Backing Up Your Target Files

Shortcut:  Get a CD-ROM Burner and back up all critical files on a data CD. Redo it
from time to time to include all your new work. Install good a good anti-virus pro-
gram and keep it’s virus-sample listing updated frequently.

If you have done all the work necessary to record your experimental projects and have also r
the performance all of your most seminal handloads, over the years, you simply MUST be su
this information is not subject to being lost through a hard disk crash or computer virus attac
best way to assure this is to install a CD-ROM "burner" (creator) in your PC and then "burn" C
store all of your critical data AWAY from your PC. In that case, if you have a catastrophic o
rence (e.g., hard drive crash or virus attack), you just fix the problem (replace or reformat you
drive), reinstall your software, including GSCalc, upload your critical files from the CD-ROM
you’ve created, and proceed. Remember that a CD-ROM burner can also back up your other
files, such as family photos and your letters. You can always re-install your software - in fact,
the only way you can get it back, so it makes no sense to "back up" your program files - it is th
that you’ve created with these programs that you cannot replace. Therefore, it’s a good idea t
where you keep your photo and document files and to back them up, along with your Target folder,
from time to time. The blank CD-ROMs cost well under 50 cents apiece and hold over 600
Bytes. That’s hard to beat.

Until you can get a CD-ROM burner drive installed, you can back-up your compact gsc files r
on 3.5" floppies.

A second important step is to purchase and install a competent anti-virus program. Once you
installed, download all the new virus definitions and re-do this downloading at least every
week. Set your anti-virus program to validate each file that comes in by e-mail or disk. Nevert
it’s always possible that you’ll get blasted with a brand-new virus or that your hard drive will c
The trick is to HAVE A GOOD FILE-BACKUP PLAN AND THEN STICK TO IT! Remember:  
ëTis far better to be prepared than to be repaired!"

Exporting Your GSCalc Target Image

Shortcut:  You can use your keyboard’s "Print Scrn" key to capture a screen image,
drop it into your image editor, crop the target image, reset the scale, and then save it
as a compact JPEG file ideal as an e-mail attachment. Grabbing the Group Statis-
tics, for including in an e-mail, is as easy as doing a mouse-sweep and Ctrl-S (in the
Group Statistics window); and then (in the e-mail) Ctrl-V. You can also save your
Group Statistics as a file and then attach it to an e-mail, just as you did with the tar-
get image.

If you are a gun writer, or just wish to send a copy of a nice target you’ve shot to a friend, via e
you’ll need to know how to capture the target image. Here’s one way that will work, most l
with the software you have on hand.

You’re going to rely on those inch/cm grid lines on the Group Size Calculator image of your target.
Therefore the Embold Target function that is handy for direct printing of the target image, bu
NOT needed when you are capturing it as follows.

Let’s say that you’ve either processed your scanned target or have opened up an existing gsc
you are now looking at the image of that target, in the full-screen size (maximized) Group Size Cal-
culator window and, floating over it is the Group Statistics window. Use Alt-Tab (hold down the
Alt key and hit the Tab key) to bring the Group Size Calculator window to the front (now  all you
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see is the target). Find and strike the Print Scrn  key on your keyboard (often just to the right of th
function keys). This places an image of the screen on your PC’s clipboard. Open your scannin
image-editing software (e.g., Adobe Photoshop or Jasc Paint Shop Pro) and paste in the image
[usually, hit Ctrl-V, or tag the Edit  tab and choose Paste (or possibly Paste As New Image). . . how-
ever, with some software, you have to create a new blank document before you can past
image from your PC’s clipboard].

The screen image will appear, ready for editing. Click on the magnifier glass tool and click it 
dead center of your group. Do this repeatedly, until the target image, including each of its in
grid lines, is clear. Now click on the "Cropping" tool (sometimes called the "Marquee Tool") an
out a cropping box that lies on grid lines surrounding your group. Don’t be worried about i
rough it in. Now adjust the edges of your cropping box to exactly overlay the inch/cm grid lin
follows: pass the cursor over the edge of the box; when the cursor changes to left/right arro
the sides of the cropping box) or up/down arrows (for the top & bottom of the cropping box
your mouse to click-and-drag the cropping box’s edge so that it is exactly over its respectiv
line; and when it’s correct, release the mouse key. Once all four box sides are dead-on th
lines, crop out everything out side the box [usually, tag the Image tab and choose Crop (or Crop
Image)].

The rest of the image disappears and you are left only with your group image, with edges cu
the target grid lines. Therefore, you know how far across and how tall the image SHOULD be
ally, you’ll get a good outcome if so long as EITHER  the left-right OR the up-down edges of the
image are bounded by grid lines, but getting all four boundaries on-grid looks best). Howeve
not currently the correct size. 

Now resize the image [usually, choose the Image tab and choose Resize (or Image Size)]. This will
bring up an image attributes window. Be sure that the box is checked that says to keep the 
shape unchanged [the box will say something like, "Maintain aspect ratio," or "Constrain Pro-
portions"]. Check that the Units frame (NOT the resolution, but the X and Y units of measure) is
at either inches or centimeters, to match the spacing of gridlines on your target image. Typica
the Resolution frame will show 72 pixels/inch (or 28.4 pixels/cm). This is way too coarse for y
purposes. Change it to 200 pixels/inch (or 78.7 pixels/cm). This resolution gives the best b
between clarity and file size. It is important to do this resolution change BEFORE resettin
image width/height.

Lastly, count the number of spaces between gridlines, across the image, and change the nu
the Width  frame to match that even number. The number in the Height frame should change
accordingly and indicate an even number (or very close to it) that matches the number of inc
of target image height. To finalize the changes, hit the OK  button. The image attributes window dis
appears and your image is now properly scaled again and has a pixel density that will give
rendition when printed.

Save your image as follows. Tag the File tab and select Save As. This brings up the Save As win-
dow. Be sure that the destination folder is correct (C:\targets\lessons, in our case) and a
appropriately, if needed. In the File name: frame, type in a useful name (no file extension [e.
.bmp], just the file name). In the Save as type: frame, click on the tab at the right of the frame, th
find and choose the JPEG option [it might look like "JPEG - JFIF Compliant (*.jpg, *.jif,
*.jpeg)"].

 With JPEG chosen, if you can find an Options button in the Save As window, punch it and choose
a JPEG compression factor somewhere between 33 and 50, then hit the OK  button to return to the
Save As window. This JPEG compression setting gives an good balance between image clar
file size. The setting will remain for future JPEG saves until you change it again.
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Lastly, hit the Save button and your properly scaled target image will be saved in JPEG format
can test-print this image right from your scanning/editing program by simply hitting Ctrl-P (or
ging the File tab and choosing Print ). As you’ll see, it prints at the right scale, just as it will for a
friend you send it to by e-mail.

Let’s say that you named the file "Bragger". In that case the folder (Lessons, in this case) would
have a file now named Bragger.jpg. It will take up only around 20 KB or so, whereas the scan
bmp image of your target required at least 120 KB. Therefore, your JPEG target image is se
compact and will work well as an e-mail attachment (big files clog up the e-mail lines). Check 
if your file is in the right folder. If you have a  My Computer  or Windows Explorer window
already open for that folder and it doesn’t show this file yet, just tag the View tab and choose
Refresh (this forces the software to reassess and redisplay the listing of files in that folder).

To send this target image to a friend, by e-mail, boot up your e-mail program, open a new e-m
fill out the To: part (choose your friend’s e-mail address). Insert your target image as an attac
fo your e-mail as follows:

• If you are using Outlook Express, click the Format tab on your message window and b
sure that the Send Pictures With Message option is checked (this shows a view, within th
e-mail your friend receives, of each attached image). If your e-mail program doesn’t
such an option, then skip this step;

• Mouse-tag the Attach button to bring up the Insert Attachment window;
• In the Files of type: frame, choose "All files (*.*) "; 
• In the "Look in: " frame, hit the tab and "drive" to your project folder (Lessons, in this

case); 
• Find and single-click on your target image (Bragger.jpg, in this case); and 
• Click on the Attach button.

The Insert Attachment window closes and your e-mail now shows an attachment window 
shows the file icon. Write up your target brag note and send it all off to your friend. . . Hey! Wh
friends FOR, after all?!

Saving Your Group Statistics Output - Normally, there’s no need to save your Group Statistics
output, given that GSCalc will recreate it each time you open that target’s cleaned-up gsc file. H
ever, you may wish to send a copy of your Group Statistics, for a given target, inside the messa
text of the e-mail that brings your target image to your friend (see above). The easiest way to
is to grab all of the text within the Group Statistics window and paste it into the body of your e
mail, as follows:

• Tag the Edit  tab and choose Select All;
• Tag the Edit  tab and choose Copy. The file’s contents are now copied to your PC’s cli

board;
• Use Alt-Tab to move to your e-mail;
• Insert your cursor at the location in your e-mail’s text where you want to paste the G

Statistics output; and
• Hit Ctrl-P (or click the Edit  tab and select Paste). You group statistics now appear withi

your message.

If you’d prefer, you can save the entire Group Statistics file as a text file (i.e., with a ".txt" file
extension, and in a format can be read by NotePad or by any word processor), as follows:

• In the Group Statistics window, click on the File tab and choose Save As; and
• Type in an appropriate file name in the File name: frame and hit the Save button.

NotePad’s default output format it as a txt file (with a ".txt" extension), and NotePad’s default desti-
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nation folder is the same one from which you opened the gsc file. Therefore, you’ll find you
file in the same project folder in which you’ve been working with (Lessons, in this case). Don’t for-
get to hit View (tab) and Refresh, if your My Computer  or Windows Explorer window fails to
show the presence of the new file. You can attach it to your e-mail in just the same way that y
with the target image (see above). Your friend can bring up this .txt file in any word processin
ware or with NotePad.

Designating Fliers

Shortcut:  RIGHT-click on any wide shots in the Group Size Calculator window
(they go blue and are ignored when you redo the group (tag Run and then choose
Recalculate & Recenter). Such flier-tagging cannot be saved.

GSCalc will let you designate wide-flying shots as fliers. All you need to do is to RIGHT-click
the divergent shot(s) in the Group Size Calculator window. Upon being so tagged, the shot’s co
will change to blue. Now hit the Run tab and select the Recalculate & Recenter option.

Both the Group Size Calculator and the Group Statistics windows will be redone as follows. In
the Groups Size Calculator, the red ball will still show the POA (or, if you’ve run the Zero Group
option, the overall group center), but the diagonal X will mark the adjusted center of the 
[ignoring the flier(s)]. The Group Statistics will be recalculated to ignore the flier shot(s) and w
also list the number of designated fliers.

You cannot save this group-showing-fliers (next time, it will come up in GSCalc with no fliers
shown), but it is a handy way to see the effect of a divergent shot. Remember, unless you 
pulled that shot, there is no reason to throw it out. . . that load just tends to give you fliers from
to time. If you don’t like that, then change the load, improve the piece’s barrel/action beddi
take other actions, but DO accept all the input your piece has given you.

One exception to this is in a case where you are using cast bullets and you suspect that some
got through the process with a little vug (cavity) in their base. If the flier is caused by a bad 
then you can re-shoot the group or add an extra shot. However, you’ll have to answer the q
for yourself as to whether that is really being truthful. I mean, unless you are going to shoot 
quality cast bullets, in normal use, than you did in your testing (raaaather odd!), then the occ
flier IS reality for that load.

The best approach is to accept all shots unless you know you pulled that shot. Look at the
side: this makes it more feasible to beat your top load’s accuracy during further load develop

Statistical Considerations For Everyone

Shortcut:  The group’s Average Radius value is the best indicator of accuracy. It’s
also the best value for making an initial comparison between groups shot with two
loads, but if the two loads have roughly the same Average Radius, the best is the one
with the smallest Radius Standard Deviation. Twice the Average Radius is the diam-
eter of round target you’ll miss around half the time at the reference distance. To esti-
mate a load’s Average Radius at a different distance, divide the Average Radius by
the number of yards at which it was shot, then multiply that number by the number of
yards for the different distance - don’t extrapolate far.

Your Best Accuracy Indicators - For just comparing groups, the Average Radius value in 
Group Statistics output is by far the most valuable measure of accuracy. For most uses, a gla
the Average Radius value of two groups is all you need to see which one is the most accurate
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want to do a more advanced statistical analysis, and have the software to do it, then you’ll 
read and consider the material in the next section (Hard-Core Statistics-Junkie Considerations).
The Radius Standard Deviation value comes in handy if you are comparing two loads with su
tially the same Average Radius value. . . in that case, the best load is the one with the s
Radius Standard Deviation. Of course, this rule doesn’t count unless both groups look typica
unnaturally-small Radius Standard Deviation of a ring-shaped group is a warning sign, not 
star.

Fifty Percent Hit Diameter - Multiplying the Average Radius by two produces a valuable numb
the Fifty Percent Hit Diameter. This is an estimate of the diameter of round object that is so
that you will "hit" it (i.e., the center of your shot will be in that circle) only around half of the ti
at that distance, under the conditions in which you shot the reference group (i.e., same s
position, distance, etc.). However, this value (50%) goes up to around 66% for a tall narrow
[e.g., a standing ground squirrel] whose width is twice the Average Radius.

The reason for this difference in hit percentages is that, when dealing with the radius as th
measure of accuracy, you have no say as to along which radius, from the center, your shot w
Therefore, on a standing ground squirrel, a center-aimed shot that lands further from the gro
ter than the mean radius value will still be a serious hit if the error happens to fall more on t
down (Y) axis than on the left/right (X) axis, because the squirrel’s height is far greater th
width (i.e., you "missed" the circle but nailed the squirrel anyway). By comparison, for a ce
aimed shot at a round target (with a diameter twice the Average Radius), if the shot’s radius
the intended center-strike point) is greater than the group’s Average Radius, then that shot is
no matter where it lands around the circular target.

So, depending upon whether you have a tall skinny target or a round one, multiplying the A
Radius by two will give you the target diameter (or width) you’ll hit between 1/2 and 2/3 of the time,
given the same conditions as those under which you shot the your reference group. Now le
about how to make that apply to distances other than the one at which you shot your re
group.

Guessing Accuracy At Different Distances - Within reason, it is possible to gauge the Average
Radius value you are likely to get at a different distance than that at which you shot your refe
group. To do this, you use proportions. For example, if you shot your reference group at 200
and obtained an Average Radius of 0.50" and you wanted an estimate of what it would be
yards, you’d divide your Average Radius value by the number of yards at which it was shot (
case, divide 0.50" by 200) and then multiply the resulting number by the number of yards f
desired distance: (0.50"/200yards) x 350yards = 0.875". In this case the Fifty Percent Hit Dia
for this load at 350 yards would be 1.75" (because 2 x 0.875" = 1.75"), so this would still be p
ful ground squirrel medicine at 350 yards.

Alternatively, you might want to know the distance that represents the outer practical bounds f
load, for a given application (say, for hitting a standing 2" wide ground squirrel at least half th
using the same position you used to fire the reference group). Lets say that you’d shot it at 10
and had obtained an Average Radius of 0.43". In that case, multiply the load’s Average Radiu
by two (to get your fifty percent hit diameter at 100 yards) and divide that into the width of you
get (2"), then multiply the answer by the distance at which you shot your reference group
yards). For our sample, we’d have: 100 yards x (2" / (2 x 0.43")) = 230 yards. Since this is
skinny target, we’ll hit it around 2/3 of the time at that distance (or, if it were a 2" diameter b
you’d smack it about half the time).

The trick with this is not to extend your distance any further than the load’s accurate range. R
too, that this estimate does not factor in the effect of such things as field shooting positions o
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conditions. Nevertheless, it’s one more really-handy thing you can do with your Average R
readout that would be meaningless if applied to the usual "group size" parameter.

Hard-Core Statistics-Junkie Considerations

{Translation: most users will want to skip this section.}

Shortcut:  There IS no shortcut, but here’s a synopsis. You can get hip-deep into sta-
tistics, if you want, but you’ll find that the Average Radius value still tells you 90%
of what you’ll ever know about a given load’s capabilities or how it shapes up rela-
tive to other loads. However, to be comparable, both groups must have been shot at
the same distance and under similar conditions (e.g., both off the bench).

Exporting Your X,Y Coordinates - If you have statistical software, like MINITAB , and want to do
statistical analysis of your target data, then you’ll need to know how to export the X,Y coord
relative to the group center of mass (COM ). That’s easy, as follows.

Load your gsc file into Notepad, as described earlier. Be careful to use only those gsc files tha
have converted to make the center of aim be equal to the COM (in our example, we added "C
the end of the file name, for that one, yielding 44_788COM.gsc). This makes the mean X value 0.0
and the mean Y value 0.00. . . just what you need.

Ignore the first line and select all of the X,Y data (insert the cursor at the left end of the firs
line, then hold down the Shift key and click at the end of the last line). All the data pairs (X,Y 
dinates) will show up as dark, when selected. Now copy them to your PC’s clipboard by eith
ting Ctrl-C or tagging the Edit  tab and selecting Copy.

Now open another copy of Notepad [note that it usually opens up right over the other copy of Note-
pad, so you’ll need to move the new copy to the side] then click in the new copy’s window and pas
the data in by either hitting Ctrl-V or tagging the Edit  tab and selecting Paste. You now have just the
data pairs, but you’ll want to replace the comma and multiple spaces between each X,Y da
with a single space, given that most statistical programs can import "space delimited data
there is a single space between each datum in the line and a hard return separating succes
of data). 

We’ll use the Replace function to do this. Tag the Edit  tab and select Replace. In the Find what:
frame, insert your cursor and type two spaces, then insert the cursor into the Replace with: frame
and type in a single space. Now tag the Replace All button and you’ll see that your X,Y data pai
are now all separated only by a comma and a single space. Clear the Find What: frame and put a
single comma in it.  Clear the Replace with: frame such that it contains nothing.  Once again tag
Replace All button and you’ll see that your X,Y data pairs are now all separated by only a s
space. Click on the Cancel button to close-out the Replace window.

Your data is now suitable for being imported into your statistics program: in Notepad, tag the Edit
tab and hit the Select All option (all the data is now highlighted); copy the data onto the clipboar
hitting Ctrl-C (or tagging the Edit  tab and choosing Copy); go to your statistics program, select tw
adjacent columns (this may require you to select the number of lines to fill too) and paste in t
(typically, just hit Ctrl-V and then choose the "space delimited data" option).

Special Statistical Concerns - For comparing two targets, using statistical software, you can e

use the radius of each shot (radius = the square root of the sum of X2 + Y2 for each data pair), rela-
tive to the target’s center-of-mass or you can compare the raw X values for horizontal variati
the raw Y values for vertical variation. Both approaches have their advantages and problems

The advantage of the compare-radiuses approach is that it is conceptually simple and requi
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one analysis. The problem with using the radii, besides having to calculate them individually,
they do NOT exhibit a "normal" (bell-shaped curve) population distribution. Therefore, you 
use typical "parametric" (number comparison) statistical methods on it - like the handy t-te
example - because such tests absolutely require normally distributed data. The trick, if us
radii of two targets, is to rank the radius data from both targets (say, for two 10-shot groups
longest radius gets a "1", and the shortest gets rank "20"). You can then run a parametric test
t-test, on the ranks, rather than on the actual radius data, because the ranks will exhibit a ve
to-normal distribution. Are we having fun yet?

The advantage of comparing the X (horizontal variation) data for the two targets and then
(vertical variation) data is that you can use the handy t-test directly on the raw data becau
data exhibits a close-to-normal distribution (or at least comes from a near-normal distribution
disadvantage is that you need to run two analyses (one for the X’s and one for the Y’s). The s
way around this is to stick to the most divergent comparison between the two targets (e.g.,
have small group width [X values], but one load has a larger height, then just compare the Y v
Given this approach, if the more divergent axis shows no statistical difference between the t
gets, then there’s no point in doing the other axis (it certainly will show no difference); and 
most divergent axis DOES show a statistically significant difference, then the two loads ARE 
ent and there’s still no point in checking out the other axis. Hmm! Sounds like a plan!

Most statistical tests come in one- and two-tailed versions. The one-tailed version puts all
"power" in determining if the difference is in one direction (i.e., Is my new group more accurate
my reference load?), whereas the two-tailed version will just test for a difference between the 
either direction. All tests have a "Null Hypothesis" - generally that there is no difference betwe
two targets. If the test shows a statistically significant difference, then one rejects this Null Hy
esis and accepts the Alternative Hypothesis - for a two-tailed test, that the targets differ or, for
tailed test, that the new load is better than the reference load.

The "Type I error rate" or "alpha level" (chance of rejecting the Null Hypothesis by chance, in 
where there is, in fact, no real difference between the loads) is something you set ahead of ti
most scientific work the standard Type I error rate is 5%, in which case you’d have a 95% ce
that your result is true (the analysis is at a 95% confidence level).

Generally speaking, you’ll want to run a two-tailed test (to see if either target is more accura
the other. . . you’re just looking for a difference) at a 95% confidence level (Type I error rate is
and a t-test, if handled as described above, will work fine for that, using ranked radius data o
raw X or Y data (with the X or Y measured from the group center-of-mass). The only except
that would be the case where you have a solid reference target and you only want to know
new load shoots BETTER  than your reference load (otherwise, you don’t care. . . you’d disc
anything equal to or worse than your reference load). In that case, you’d run a one-tailed test
if the new load is more accurate) at a 95% confidence level (error rate is still 5%, but the po
detect an improvement is about twice what it’d be with the two-tailed version). However, in 
the two targets have to show very obvious difference in accuracy level before the diffe
becomes statistically significant.

The use of "limit-based" statistical analyses (e.g., the upper 95% tolerance limit or upper 95
diction limit) is handy for determining things like the diameter of target you would miss only 5
the time, at that range, but such tests are far beyond the scope of this humble manual.

This all leads us back to just using the simple Average Radius parameter instead of doing all th
fancy statistics. The Average Radius value is difficult to calculate, manually, but GSCalc outputs it
as standard fare . . . sometimes the simplest way really IS the best way.
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Hey! Who Wrote This Stuff?
It’s all done by serious shooters for serious shooters. That’s why GSCalc gives you what you need
does it quickly, and does it right the first time.

The Program - Ralph Wilson designed and coded the GSCalc software. All questions concerning
the program and the manual should go to him. Ralph is a hardware design manager for Age
tems, Inc. and spends far too much time at work and not near enough time pulling the trigge
latest acquisition. He’s a member of GOA, SAS, the Illinois State Rifle Association, a Life Me
of the NRA and a Life Member of the Aurora Sportsmen’s Club. He’s active in the monthly rifle
tol matches at ASC, and manages their rifle/pistol web site (http://aurorasc.org). He’s also basically
lazy (but not stupid) and likes to make tools do the work for him. One day after a session at th
trying to figure out which brand of ammo worked best with his "new" Model 52, and after spe
more time with a pair of calipers and a calculator than with the gun itself, he decided there ha

a better way. Enter the combination of flatbed scanner, PC, and Visual Basic©.  A couple weeks later
the initial version of GSCalc was born. He initially designed it simply for himself so paid little atte
tion to the user interface. With the explosion of the internet he acquired his own web sit
decided to make the program publicly available. Many thanks go to the many users of the p
who have provided very useful suggestions for improvement to both the technical conte
usability of the program.

In addition to GSCalc, he has also written an external ballistics calculator (http://rawilson.net/share-
ware/Trajectory/index.html) that is available as shareware, and makes available free a bore 
calculator for use in bore-sighting your gun (http://rawilson.net/shareware/BoreScope/index.html).

The Manual - The writer? He’s a major GSCalc user named Ed Wosika. He is the New-Produ
Design & Development Chief for the shooter’s tool company The Hanned Line [ http://
www.hanned.com/ ]. He writes frequent target-analysis-related articles for the Cast Bullet Associa-
tion 's members-only journal, The Fouling Shot[see: http://www.castbulletassoc.org/]. You can
view his other articles under the "Guest Speakers" and "Back Issues" listings at The Sixgunner
website [http://www.sixgunner.com/ ] and can view his handmade knifes there too [look for Zeek's
Handmade Cutlery, under the Businesses listing at The Sixgunner website]. He is also the co-
of The Shootists' Newsletter. In his spare time, he works as a geologist for the State of Califo
Ed offered to write the manual because he knows the value of competent target analysis an
you to get as much benefit, from using GSCalc, as he has.
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